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2025V4SDB Student
Winter School Information

The course focused on the computational analysis of various
large imaging datasets. During the course we had five practical
sessions, when the participants had the opportunity to gain
hands-on experience in the in silico processing of large imaging
datasets (e.g. volume electron microscopy, calcium imaging,
lightsheet microscopy, cell tracking).

As part of the course we also had a public lecture about the
best practices in Open Science by Gáspár Jékely (see: https://
danio-elte.github.io/2025V4SDBStudentWinterSchoolMaterials/
open_science.html).

Our target audience were graduate students (both at MScand
PhD level).

Thanks to generous funding by the “Mecenatúra” Program of the
Hungarian National Research, Development and Innovation Office
(NRDI/NKFIH - MEC_SZ-149306) and the ELTE Excellence Fund
this event was generously subsidised with no registration fees.

Lecturers

• Gáspár Jékely - Centre for Organismal Biology, Heidelberg,
Germany
• Joanna Pylvänäinen - Åbo Akademi University, Turku, Finland
• Isaac Bianco -University CollegeLondon, London,UK
• Kenzo Ivanovitch -University CollegeLondon, London,UK
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2 2025V4SDB Student Winter School Information

• Giulia Bertolin -Insitute ofGenetics andDevelopmentofRennes,
Rennes, France
• Adriana Nagy-Dăbâcan -Transylvanian Institute of Neuro-
science,Cluj-Napoca, Romania

Organizer:
Máté Varga -ELTE Eötvös Loránd University,Budapest, Hungary



Chapter 1

2025V4SDB Winter School
Programme

Tuesday, January 28

Time Activity
13:00-14:00 Registration
14:00-15:00 “Open Sciencein (In)Action: Why, What, and

How” Public Lecture by Gáspár Jékely
15:00-16:00 CoffeeBreak, Registration
16:00-17:30 Flash Talks by Students
20:00-23:00 Social Program (at The Grund)

Wednesday, January 29

Time Activity
09:00-11:00 Morning SessionI (Gáspár Jékely)
11:00-11:30 CoffeeBreak
11:30-13:00 Morning SessionII (Gáspár Jékely)
13:00-14:30 Lunch (buffet)
14:30-16:30 Afternoon SessionI (Joanna Pylvänäinen)
16:30-17:00 CoffeeBreak
17:00-18:30 AfternoonSessionII (Joanna Pylvänäinen)
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4 CHAPTER 1. 2025 V4SDB WINTER SCHOOL PROGRAMME

Thursday, January 30

Time Activity
09:00-11:00 Morning SessionI (Isaac Bianco)
11:00-11:30 CoffeeBreak
11:30-13:00 Morning SessionII (Isaac Bianco)
13:00-14:30 Lunch (buffet)
14:30-16:30 Afternoon SessionI (Kenzo Ivanovitch)
16:30-17:00 CoffeeBreak
17:00-18:30 Afternoon SessionII (Kenzo Ivanovitch)

Friday, January 31

Time Activity

11:00-11:30 CoffeeBreak
11:30-13:00 Morning SessionII (Adriana Nagy-Dăbâcan)
13:00-13:30 Closing remarks, Lunch (take away)

Ĺ Programme notes

• All sessions included breaks tomaintain engagementand provide net-
working opportunities

• A social programwas scheduledfor the first eveningat The Grund
• Giulia Bertolinʼs sessionon Thursday morning had to be cancelled
due to vis maior situation

Location
The Winter School took place on the premisesof the Faculty of Science of
ELTE Eötvös Loránd University (Pázmány Péter stny. 1/A, 1117
Budapest), in room 0.83 (“Eötvös terem”).



Chapter 2

Analysis of the Platynereis
dumerilii connectome using
the CATMAID web
interfaceand the API

Instructor:
Gáspár Jékely (Centre for Organismal Studies, Heidelberg University)
gaspar.jekely@cos.uni-heidelberg.de

2.1 Workshop Overview
Neuronal connectomics relies on ever increasing datasets of volume electron
microscopy(vEM) data that are analysedeither manually (skeletonisation) or
by AI-assisted segmentation tools, followed by extensive proofreading. The
workshopwill give an introduction into the web-basedcollaborative tracing and
annotaton platform CATMAID used for connectomeanalysis. The first part
will explorethe CATMAID web interface and introduce into the core functions.
We will analyse a large dataset from our laboratory containing the whole-body
connectomeof the larval stage of themarine annelid Platynereis dumerilii, our
model organism. In the secondpart, we will try to repeat someof the analysis
by using RStudio and the R packageNatverse. This packageaccessesthe same
CATMAID websidevia the API (application programminginterface) and can
fetch data from our connectome server. The data can then be analysed in
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CHAPTER 2. ANALYSISOF THE PLATYNEREIS CONNECTOMEUSING CATMAID

standard R workflows of network analysis, plotting,statistics, figure assembly
and paper writing. I will also give a brief introduction into this open science
workflow, as it is used in our lab.

2.2 Software

2.2.1 First Part

CATMAID -The Collaborative Annotation Toolkit for Massive Amountsof
Image Data

(Web-based software, no installation needed)

We will use the public EM resourcesof the Jékely lab and look into the whole-
body connectomeof the Platynereis dumerilii larva.

2.2.2 Second part

Accessing CATMAID via the API from RStudio.

InstallRStudio:

• An integrateddevelopmentenvironment(IDE) toworkwith R andPython

Install necessary packages fromRStudio, includingNatverse/Catmaid:

• R tools for quantitative neuroanatomy,a packagethat provides accessto
the CATMAID API for R users.https://github.com/natverse/rcatmaid

Install the Tidyverse:

• a set of packagesthat work in harmony becausethey share commondata
representationsand API design

We will usethe followingGitHub repo: https://github.com/JekelyLab/ELTE_
Catmaid_course_25

Here are detailed instructions about what to do.

Repo of the Platynereis connectomepaper, including the code for all analy-
sesand figures: https://github.com/JekelyLab/Platynereis_3D_connectome_
2024

2.3 References

Schneider-Mizell,C.M., Gerhard, S., Longair, M., Kazimiers,T., Li, F., Zwart,
M. F., Champion,A., Midgley, F. M., Fetter, R. D., Saalfeld, S., & Cardona,
A. (2016).Quantitative neuroanatomy for connectomics in Drosophila.
eLife, 5, e12059.https://doi.org/10.7554/eLife.12059
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Bates, A. S., Manton, J. D., Jagannathan, S. R., Costa, M., Schlegel, P.,
Rohlfing, T., & Jefferis, G. S. (2020). The natverse, a versatile toolbox
for combining and analysing neuroanatomical data. eLife, 9, e53350.
https://doi.org/10.7554/eLife.53350
Verasztó,C., Ueda, N., Bezares-Calderón,L. A., Panzera, A., Williams, E. A.,
Shahidi, R., & Jékely, G. (2017).Ciliomotor circuitry underlying whole-
body coordination of ciliary activity in the Platynereis larva. eLife, 6,
e26000.https://doi.org/10.7554/eLife.26000
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Chapter 3

Object Tracking and Track
Analysis usingTrackMate
and CellTracksColab
Instructor:
Joanna Pylvänäinen (Åbo AkademiUniversity)
joanna.pylvanainen@abo.fi

3.1 Workshop Overview
In life sciences, tracking objects within movies is crucial for quantifying the
behaviour ofparticles, organelles,bacteria, cells, and entire organisms. However,
tracking multiple objects across numerous movies and analysing the objectsʼ
movementscan bechallenging. This workshopaims to demonstrate the effective
utilization of TrackMate for object tracking acrossmultiple movies through
hands-onexercises.Additionally, participants will learn howto compile, analyse,
and explore the acquired tracking data using the CellTracksColab platform.
Both tools offeruser-friendlyinterfaces tailored to life scientists without coding
experience.

By the end of this workshop, participants will be familiar with TrackMateʼs
tracking capabilities, will have analyzed tracking data using CellTracksColab,
and will know howto export and visualize their results for further research.

Workshop slides available on thewebpage: https://danio-elte.github.io/
2025V4SDBStudentWinterSchoolMaterials/cell_tracking.html
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CHAPTER 3. OBJECT TRACKING ANDTRACK ANALYSIS USING TRACKMATE

3.2 Software:
TrackMate: -An open-sourceFĲI/ImageJ plugin for tracking cells/particles
in 2Dmicroscopy images.

CellTracksColab: -A cloud-basedplatformfor analyzing tracking data.

3.3 Hands-onwith TrackMate andCellTracksCo-
lab

3.3.1 If you want to test the tools during the workshop
please do these before the workshop:

1. Download these datasets:

Link to Zenodo

• 0_Tracking_settings.zip
• 1_TrackMate_batcher_input.zip
• 2_CellTracksColab_input.zip

2. Download and prepare Fĳi

• DownloadFĳi

• if new to Fiji hereare sometraining materials onZenodowith step-by-step
exercises

• OpenFĳi and activateTrackMate Helper updatesite. Restart Fĳi.

3. You need to have access to GoogleDrive (personal or create one for
the purpose of this course)

• Unzip the 2_CellTracksColab_input.zip and upload it to your
GoogleDrive

• Create a new folder on you GoogleDrive called Results

3.4 Workshop step-by-step:
1. Cell Trackingwith TrackMate

• Open Fiji and open the image_for_tracking_settingsimagefrom the
0_Tracking_settings folder.

• Definetrackingparametersin the TrackMate interface.
• Save traking settings as XML for batchprocessing.
• Open the TrackMate batcher to Batch process all images from the

1_TrackMate_batcher_input folder.
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• Export tracking data (spot tables,track tables,movies).
2. Analyze TrackMate output in CellTracksColab.
• Upload your tracking results to your Google Drive. Make sure that the
folders are correctly organized.

• You can also use the pre-made CellTracksColab input from the
2_CellTracksColab_input folder

• Create a new folder for results
• Open The CellTracksColab TrackMate notebookandmakea copy to your
drive.

• Run all cells to visualize tracks and to generateplots.
• Bonus: Utilize advanced dimensionality reduction techniques to under-
stand your data using Dimensionality Reduction notebook

Check
out
the
video
from
I2K:
https:
//
www.
youtube.
com/
embed/
fIE4i3G7L9Y

3.5 References
TrackMate Ershov, D., Phan, M. S., Pylvänäinen, J. W., Rigaud, S. U., Le
Blanc, L., Charles-Orszag,A., Conway, J. R. W., Laine, R. F., Roy, N. H.,
Bonazzi,D., Duménil,G., Jacquemet,G., & Tinevez,J. Y. (2022).TrackMate
7: integrating state-of-the-artsegmentation algorithms into tracking
pipelines. Nature Methods, 19(7), 829–832. https://doi.org/10.1038/s41592-
022-01507-1
CellTracksColab Gómez-de-Mariscal,E., Grobe, H., Pylvänäinen, J. W.,
Xénard, L., Henriques,R., Tinevez, J. Y., & Jacquemet, G. (2024). Cell-
TracksColab is a platform that enables compilation, analysis, and
exploration of cell tracking data. PLOS Biology, 22(8), e3002740.
https://doi.org/10.1371/journal.pbio.3002740
T-Cell Dataset Guillaume Jacquemet. (2023). T cell dataset for Cell-
TracksColab -2 [Data set]. Zenodo. https://doi.org/10.5281/zenodo.8420011
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Chapter 4

Analysis of Calcium
Imaging Data
Instructor:
Isaac Bianco (University CollegeLondon)
i.bianco@ucl.ac.uk

4.1 Workshop Overview
In vivo imaging of calcium dynamics can shed light on a broad range of biologi-
cal processesfrom cell migration and tissue morphogenesisto multiple aspects
of neuronal activity. In neuroscience,a combination of modern genetically en-
coded calcium sensors alongside advances in imaging technology are enabling
the activity of tens ofthousandsofneuronsto bemonitored in behaving animals.
In parallel, advances in data processingand analysis are enabling researchersto
make senseof vast population activity datasets.

In this workshop,we will:

1) introduce the key principles of calcium imaging;
2) learn how to process raw calcium imaging data and extract estimates of

neuronalactivity;
3) examineways to explorelarge population activity datasets and relate neu-

ral dynamics to sensorystimuli, task variables, and animal behaviour.

Workshop slideswill be available here
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14 CHAPTER 4. ANALYSIS OF CALCIUM IMAGING DATA

4.2 Software
Fiji: -An open-sourceimage processing package.

Suite2p

• followthe instructionsunder Local Installation
• besureto install theGUI version: python -m pip install suite2p[gui]
• ontheMac youmayneedto use: python -m pip install 'suite2p[gui]'

Rastermap

• followthe instructionsunder Local Installation
• again, be sureto install the GUI version
• it should be fine to install it in the same suite2p environment as used
above

4.3 Datasets
1. a small calcium recording that we will look at in FĲI link (You will
needto click on the Download raw file button to download the dataset.)

2. a large calcium imaging movie for Suite2p testing

• downloadany oneof the TIFF stacksin this folder link

3. a zebrafish calcium imaging movie for Suite2p testing link

4. a zebrafish activity dataset for Rastermap testinglink

• plus someextra files to help interpret the fish dataset link

4.4 Install the Python environment
1. Install an Anacondadistribution of Python

2. Using either the commandline or the AnacondaNavigator, create a new
environment
a. Command line: conda create --name suite2p python=3.9 or
b. Anaconda Navigator, seepic below
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16 CHAPTER 4. ANALYSIS OF CALCIUM IMAGING DATA

3. Using the commandline (open “Terminal” on the Mac), activate the
suite2p environment: conda activate suite2p

4. Now install suite2p by typing: python -m pip install suite2p[gui]

oronthe Mac youmight need: python -m pip install ‘suite2p[gui]’
(notice the ʻ )
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5. Once the download is finished, launch suite2p: python -m suite2p

All done!
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4.5 References
Suite2p Pachitariu M, StringerC, DipoppaM, et al. (2017)Suite2p: beyond
10,000 neurons with standard two-photon microscopy. bioRxiv https:
//doi.org/10.1101/061507
Suite2p documentation: https://suite2p.readthedocs.io/en/latest/
OASIS Friedrich, J., Zhou, P., & Paninski, L. (2017). Fast online decon-
volution of calcium imaging data. PLOS Comp Bio, 13(3), e1005423.
https://doi.org/10.1371/journal.pcbi.1005423
Rastermap Stringer, C., Zhong, L., Syeda, A., Du, F., Kesa, M., & Pachi-
tariu, M. (2025).Rastermap: a discoverymethod for neural population
recordings. Nat Neurosci, 28(1), 201–212. https://doi.org/10.1038/s41593-
024-01783-4



Chapter 5

Introduction to Bonsai
Instructor:
Adriana Nagy-Dăbâcan (Transylvanian Institute of Neuroscience) daba-
can@tins.ro

See Github link here.

5.1 Workshop Overview
During the session,wewill presentBonsai asa reactive programmingtool usefull
when designingand analyzing behavioral experiments. We will go through the
potential applications for Bonsai and its most relevant usecases.Then, we will
get familiar with this tool by implementing a simpleworkflowcombininganimal
tracking with closed loop control. We will showcasebasic programmingprinci-
ples and will open the door for addressingmore complexneedsin experimental
design.

By the end of the workshop,participants will be familiar with Bonsai as a tool
for behavioral experimental control and will understand its basic principles of
operation. They will have a goodsourceof documentation and will be able to
join the community for further support.

Workshop slides are available on thewebpage: https://danio-elte.github.io/
2025V4SDBStudentWinterSchoolMaterials/bonsai.html
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20 CHAPTER 5. INTRODUCTION TO BONSAI

5.2 Software
Bonsai:
• An open-sourcevisual reactive programmingsoftware for interactive sys-
tems.

• built to workwith .NET frameworkin Windows 7 or later.
• for Linux installation, seepointers here.

5.3 Prepare the field
• Downloadand install Bonsai.
• Install the Starter Pack fromthe PackageManager.
• Check out the Bonsai Gallery and makesure the exampleworkflowswork
on your station.

• Download the video file for this workshop.

5.4 Workshop step-by-step
1. Open and visualize video file.
2. Detect animal using simple image processingfunctions.
3. Compute centroid coordinates in arena.
4. Implement simple conditionals using Logical operators.
5. Integrate python scripting for more complexlogics.
6. Trigger somedigital line/speaker when animal leaves predetermined home
area.

5.5 Bonsai Resources
• Documentation
• Github Forum
• Public DiscordServer
• Learning Resources

5.6 References
Lopes,G., Bonacchi, N., Frazão, J., Neto, J. P., Atallah, B. V., Soares,S., …&
Kampff, A. R. (2015). Bonsai: an event-basedframework for processing
and controlling data streams. *Frontiers in Neuroinformatics**,9,7. https:
//doi.org/10.3389/fninf.2015.00007



Chapter 6

Introduction to live analysis
of gastrulation and heart
development in mouse
Instructor:
Kenzo Ivanovitch (University CollegeLondon)
k.ivanovitch@ucl.ac.uk

6.1 Workshop Overview
Investigating the collective behaviorsand cell fate decisionsthat drive tissueand
organ development requires live-imaging technologies capable of bridging molec-
ular and organ scales, while also supporting long-term imaging over periods
ranging from tens of hours to days. In this tutorial, I will present our research
on heart development and demonstrate how light sheet microscopy, combined
with advanced image analysis, can help answer fundamental questions in devel-
opmental biology.

Workshop slideswill be available here

6.2 Software
Fiji:

• An open-sourceimage processing package.
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CHAPTER6. LIVE ANALYSIS OF GASTRULATION ANDHEART DEVELOPMENT

Bigsticher

• The BigStitcher is asoftwarepackagethat allowssimpleandefficientalign-
ment of multi-tile and multi-angle image datasets, for example acquired
by lightsheet, widefield or confocal microscopes.

MaMuT

• A Fĳi plugin for the annotation ofmassive,multi-viewdata.

Ď Tip

Within Fiji: Help › Update…, click Manage update sites and select
BigStitcher and MaMut in the list. After applying the changesand
restarting Fĳi, BigStitcher and MaMut will be available under Plugins
› BigStitcher › BigStitcher and Plugins › MaMut

RStudio:

• An integrateddevelopmentenvironment(IDE) toworkwith R andPython
https://posit.co/downloads/

Anaconda

6.3 Data
This is the data directory.

6.4 Workshop step by step:
6.4.1 1. Movie registration
We will be using BigStitcher to register the embryo in both space and time.
This step is crucial, particularly if your goal is to track cells and analyse, for
example,their migratory behavior. Without this registration, your resultscould
be confounded by the movement of the embryo during acquisition.

6.4.2 2. Generation of Lineage tree
You will manually track cells using MaMut to generate lineage trees. This
process is essential for addressing when cells becomerestricted in their lineage
potential during development.

6.4.3 3. Representation of the Trajectories in 3D
You will reconstruct the 3D trajectories of cells, enabling you to assesshow
migratory behavior relates to cell fate specification.



6.5. REFERENCES 23

6.5 References
Bigstitcher Hörl, D., Rojas Rusak, F., Preusser,F., Tillberg, P., Randel, N.,
Chhetri, R. K., Cardona, A., Keller, P. J., Harz, H., Leonhardt, H., Treier,
M., & Preibisch, S. (2019). BigStitcher: reconstructing high-resolution
image datasets of cleared and expanded samples. Nature Methods16(9),
870–874. https://doi.org/10.1038/s41592-019-0501-0
MaMuT Wolff, C., Tinevez, J. Y., Pietzsch, T., Stamataki, E., Harich, B.,
Guignard, L., Preibisch, S., Shorte,S., Keller, P. J., Tomancak,P., & Pavlopou-
los, A. (2018). Multi-view light-sheet imaging and tracking with the
MaMuT softwarerevealsthe cell lineageofa direct developingarthro-
pod limb. eLife, 7, e34410.https://doi.org/10.7554/eLife.34410
Shayma Abukar, Peter A. Embacher, Alessandro Ciccarelli, Sunita Varsani-
Brown, Isabel G.W. North, Jamie A. Dean, James Briscoe, Kenzo Ivanovitch
(2023) Live-imaging reveals Coordinated Cell Migration and Car-
diac Fate Determination during Mammalian Gastrulation. bioRxiv
2023.12.19.572445.https://doi.org/10.1101/2023.12.19.572445
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